
 
 

DiPS 2025 Release 1 
 
For the DiPS Website please use our secure link https://www.dips.co.uk when accessing Customer Zone 
resources and replace any existing bookmarks or links with https as appropriate. The DiPS website has all 
the necessary links to download complete installations or patches for existing setups. Available are the 
latest program releases, setup installation files, and patches for postcodes and Ordnance Survey maps. 
If you don’t already have access to our customer zone, we can provide users with a specific logon and 
password to get to the relevant web pages from the Login Page. To get this information, please contact 
us by email at support@dips.co.uk. Once you have the necessary information, please follow the steps 
outlined below. 
 
1. Go to https://www.dips.co.uk 
2. Select “Customer Zone” and the click on the button to 

access the DiPS Customer Zone 
3. At the Windows Security dialog you need to put in your 

Username and Password and click OK. 
(please note both are case sensitive) 
 
 
Click on the button for Customer 
Zone 
 
 
 
 
 
 
 
 
 

 
 
 
 
Use the latest DiPS Installation Files link…….. to 
access the system.zip file.  
 
  
 
 
 
 
Open or Unzip this file into a folder to access the 
required installation files. 

 
 
 

https://www.dips.co.uk/
mailto:support@dips.co.uk
https://www.dips.co.uk/


DiPS Installation for a brand new PC / laptop that has just been delivered 
with a new Windows Install  
 
For a newly delivered PC or laptop that has a new Windows installation please check first that the following 
Windows – Core Isolation – Memory integrity setting is not ON as this will prevent blue USB DiPS dongles from 
working properly. 
 
 
This can be done in Windows as below :- 
 
 
Windows Settings – Windows Security – Device Security – Core Isolation – Memory integrity - must be OFF 

 
 

 



 
 
Update Summary for New Release Features –  

 
New Features 
 
Recovering DiPS (e.g. unknown passwords etc) 
New Updater options in the DiPS Program and via icon 
Help menu – Check for Program Update 
OrderCSV option to allow Collect Flag = Y as well as C 
Updates to Itinerary display 
Interface & Program Updates (specific company info will be emailed separately) 
Password code Changes to update Dongle permissions 
Road Changes including new A30 in Cornwall 
 
 
 
Updated Web-Site 
 
The DiPS web-site has been upgraded to now run on a dedicated server platform which will make 
downloading data faster and more robust. 
 
 
 
Other Recent Notes & Information 
 
Route menu option Graphics Display for Roads – Showing all trips with roads 
Improved Display to pick up different Road Speed Tables (such as Rush Hour or Lorry Ban) 
Downloading OS Maps by Area 
New Metal Dongle Types 
Deskey Dongle Drivers 2021 – version 3.15.0.17 now included 
Windows 11 
Road Network Changes & Postcode Updates 
New Ordnance Survey background Maps available 
Customer Reports & Configuration Files Download from DiPS Web Site 
Downloading Maps from DiPS Web Site 
Instructions for Installing Software & OS Mapping  
 



Recovering from an unknown DiPS Password 
 
Run DiPS and type in your normal User ID but then in the password field type in the word   ERASOR 

That will then display the DiPS installation Profile dialog. 

On here, the Define a new password field should show the current password. 

Make a note of this and then Click Cancel at that point (passwords aren’t case sensitive) 

 

 
Then to access DiPS normally, simply re-run DiPS again and use the password. 

 
To change the Password once the program is running 
 
Use the File menu, then Study and Settings 
 

 
 
This should then display the Study Settings and DCP dialog. 
 
Click the Change Setup button at this point and that will display the Profile dialog as above again to enable the 
Password to be changed. 
 
Recovering DiPS 
 
The web-page - https://www.dips.co.uk/recover has useful information when problems occur. 
 
Issue such as :- 
DiPS locks up or closes unexpectedly after the Logon dialog runs as normal  
Dongle Not Found 
Closing the DiPS New Egotrip Program using Task Manager 

 

https://www.dips.co.uk/recover


 

New Updater options in the DiPS Program 
 

 
 
Run the DiPS Program Updater program from the Windows All apps menu item.  
 
This will check for Updates on the DiPS web-site and then show the following dialogs :- 
 

 
 
Use the Check for Updates button to see if a new version is available. 
 
If so, the Installed Version option will display  (in the example above    2024.1   ->    2024.2) 
 
The program is available for download from the DiPS web-site folder https://www.dips.co.uk/2015Downloads 
 
The main DiPS program file required is   m3.exe 
 
The default Browser will run and the show the file available for download. 
 
Change the folder location to show your DiPS folder (e.g.  C: > DIPS > WIN ) 
 
Over-write the existing m3.exe program by setting the File name as   m3.exe  
 
Click   Save   to update the program version and Confirm as required 
 

http://www.dips.co.uk/2015Downloads


 
 
 
 
 
If DiPS is running when the Updater is started and new version option chosen, the following dialog appears :- 
 

 
 
Close the DiPS program and then click the  Retry  button 
 
 
 
 
 
In the DiPS program use the Help menu option – Check for Program Update 
 

 
 
Program will close and then the program will run as above. 
Simply re-run the program once the process has completed. 
 
 

  



Program & Features Update 
 

 
New Route menu option for graphic map display – Showing all trips with roads. 
 
With this option it is possible to see deferred Orders alongside the route taken for an existing route as a visual guide 
to see if that route drives close to other drops, making them feasible options to add to the route. 

 

 
 
 
 
 
Both menu options to show roads used on route displays have now been improved to display roads including those 
set by Lorry Ban / Rush Hour if appropriate for that trip. 
 
 
Updated Program Now Showing Roads as set by Lorry Ban / Rush Hour if appropriate 
 

 
 
 
 
 



Previous Versions showed Default Roads 
 

 
 
 
 
 
 
 
 
 
 
 



Downloading OS Background Maps by Area 
 
The OS Download file downloads are quite large so it may take a while to process them.  
Rather than one big UK-wide file in these cases, we’ve split 50K and Street Level mapping into various smaller 
regional files to make downloading quicker and easier. 
 
For the StreetView mapping please use these links for separate areas :- 
 

 
https://www.dips.co.uk/2015Downloads/SV%20Mids1.zip  - Midlands 1  
 
https://www.dips.co.uk/2015Downloads/SV%20Mids2.zip  - Midlands 2 
 
https://www.dips.co.uk/2015Downloads/SV%20North1.zip  - North 1 
 
https://www.dips.co.uk/2015Downloads/SV%20North2.zip  - North 2 
 
https://www.dips.co.uk/2015Downloads/SV%20SouthEast.zip  - South East 
 
https://www.dips.co.uk/2015Downloads/SV%20SouthWest.zip  - South West 
 
 
These should add the 50K OS background maps :-.. 
 
https://www.dips.co.uk/2015Downloads/50K%20north.zip  - North 
 
https://www.dips.co.uk/2015Downloads/50K%20sw.zip   - South West 
 
https://www.dips.co.uk/2015Downloads/50K%20mids.zip   - Midlands 
 
https://www.dips.co.uk/2015Downloads/50K%20se.zip   - South East 

 
 

 
 
 
You just need to drop the folders within the zip files into the appropriate OS folder on your C: disk  

1. Create a new folder in the C: disk called       OS 50K Raster 

https://www.dips.co.uk/2015Downloads/SV%20Mids1.zip
https://www.dips.co.uk/2015Downloads/SV%20Mids2.zip
https://www.dips.co.uk/2015Downloads/SV%20North1.zip
https://www.dips.co.uk/2015Downloads/SV%20North2.zip
https://www.dips.co.uk/2015Downloads/SV%20SouthEast.zip
https://www.dips.co.uk/2015Downloads/SV%20SouthWest.zip
https://www.dips.co.uk/2015Downloads/50K%20north.zip
https://www.dips.co.uk/2015Downloads/50K%20sw.zip
https://www.dips.co.uk/2015Downloads/50K%20mids.zip
https://www.dips.co.uk/2015Downloads/50K%20se.zip


 
 

2. Open each of the three 50K zip files in turn and then Copy and Paste the folders into the   OS 50K 

Raster   folder 

 
 
 

3. After this create another new folder in the C:   disk called       OS StreetView Raster 

4. Repeat this copy and paste process for the four  SV  files in turn and put them in this  OS StreetView 

Raster  folder  

 
 
 
 
 
 
Then all the map folders & files 
will appear in the 2 main folders. 
 
 
 
 
 

 
 
 



New Metal Dongle Types 
 
We are now issuing new type metal USB licenses for replacement licenses or newly purchased licenses. 
These dongles are interchangeable with blue plastic licenses and function in the same way. They may 
also be used on previous software versions of DiPS if required. Updates may be needed to the deskey 
drivers where necessary. Please contact DiPS for more advice or refer to the following section. 
 

 
 

 

 

New type metal USB licenses have a serial number on one 

side starting with   3 – 

 

Live licenses are marked with  L  on one side 

 

Backup dongles marked with  B  as shown on the left 

 



Deskey Dongle Drivers 2021 – version 3.15.0.17 
 
As part of the new DiPS Setup program, the new 2021 update Deskey drivers are also installed that 
support use of the blue USB DiPS Dongles. This install isn’t mandatory for any existing DiPS installations 
and any previous dongle drivers will be backward compatible.  
 
The new install routine now checks for any program running such as the DiPS m3.exe program that may 
be using existing drivers and will present a message (below) for you to close the program accordingly. 
 

 
 
If the program remains open another dialog will appear allowing you to abort the Deskey install, close 
the DiPS program and then re-run the Deskey install again if necessary. 
 
 
 

 



New Installation Program for Software & Maps 
 
Use the DiPS Installation Files link on the web to access the system.zip file. Open or Unzip this file into a 
folder and run the DIPS_Install.exe program to install the software. 
 
 
Update An Existing Software Installation  
 
 
 
Follow the installation wizard to complete each 
screen. Initially you will see a Welcome screen. Click 
on Next , Back or Cancel as required to move through 
the installation. 
 
 
 
 
 
 
 

 
 
 
If the setup routine detects the same version a confirmation dialog 
will appear. 
Use either Yes (to uninstall the existing version if required) or 
No to overwrite (replace existing programs) 
 

 
 
In the Destination Folder section, setup will 

automatically find an existing system 
or for a new installation you will need to select a 
directory for the DiPS folder (e.g. C:\DIPS).  
 
To Update an Existing DiPS system, options for 
Custom Reports and New Install are not 
usually required unless re-installing these. 
 
Click Next to continue. 
 

 
 
 

 
 
 
New shortcuts will be added to your Start Menu options in the 
DiPS folder and on the desktop as required. 
 
To Update an Existing DiPS system, icons are usually in place so 
unless re-installing these, un-tick as necessary. 
 
 
 



 
 
 
 
 
A summary dialog of the options chosen will then show 
 
 
 

 
 
 
 
 
 
 
 
Progress Indicators will then show as the files are being copied. 
 
 
 
 
 
 

 
Installing Ordnance Survey Basic Mapping from a System Installation 
 
The main DiPS setup program has now been amended to add the facility to load on the latest versions of the basic 
level OS Maps as these don’t incur a great overhead in terms of space requirements. The two folders included are 
for OS Miniscale Raster and OS 250K Raster which display at the highest level (e.g. when looking at a map of the 
whole UK or a region rather than a detailed view of a town). 
 
 
Follow the installation wizard to complete each 
screen. Initially you will see  Welcome screens. 
 
 
 
Click on Install to continue or use the Options button 
to change the default location of C:\ 
 
 
 
 

 
 
If the setup routine detects the same version a 
confirmation dialog will appear. 
Use either Yes (to uninstall the existing version if 
required) or 
No to overwrite (replace existing programs) 

 
 
 
 



 
 
 
 
 
 

 
 
 
To install the mapping onto C:\, simply click Install to start the copy process. 
 
 
 
 
To choose an alternative drive, click on the 
Browse button to display other drives and select 
the required destination. Select only the drive 
and not a folder as the files are copied into 
folders as required.  
 
 
 
 
 
 
 

Click Next after this to start copying files. 
 
 
 
 
 
 
 
 
 



 
 
 
Basic Software Installation on a New PC 
 
 
 
 
Follow the installation wizard to complete each 
screen. Initially you will see a Welcome screen. Click 
on Next , Back or Cancel as required to move through 
the installation. 
 
 
 
 
 
 
 
 
 
 
In the Destination Folder section, setup will 
automatically find an existing system or for a new 
installation you will need to select a directory for 
the DiPS folder (e.g. C:\DIPS).  
 
 
 
Initially the New Install System Installation option 
will need to be used to install a basic setup on a 
new PC. 
 
Tick the New Install Option if appropriate 
 
Click Next to continue 
 
 
 
 
A New Install full installation will add some standard Environment Variables.  
(For example for a system installed on the c: drive - arcdrive=c:, arcpath=\dips\archive, dips=c:, and rootpath=c:\).  
 
 



 
 
 
New shortcuts will be added to your Start Menu 
options in the DiPS folder and on the desktop as 
required. 
 
The DiPS New Egotrip icon will launch the main 
program.  
 
 
 
 
 

 
 
A summary dialog of the options chosen will then 
show 
 
 
 
 
 
 
 
 

 
 
 
Progress Indicators will then show as the files are being copied. 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Installing Ordnance Survey Basic Mapping from a System Installation 
 
The main DiPS setup program has now been amended to add the facility to load on the latest versions of the basic 
level OS Maps as these don’t incur a great overhead in terms of space requirements. The two folders included are 
for OS Miniscale Raster and OS 250K Raster which display at the highest level (e.g. when looking at a map of the 
whole UK or a region rather than a detailed view of 
a town). 
 
 
Follow the installation wizard to complete each 
screen. Initially you will see  Welcome screens. 
 
 
 
Click on Install to continue or use the Options 
button to change the default location of C:\ 
 
 

 

To install the mapping onto C:\, simply click Install to start 
the copy process. 
 
 
 
 

To choose an alternative drive, click on the Browse button to display other drives and select the required 
destination. Select only the drive and not a folder as the files are copied into folders as required.  
 
Click Next after this to start copying files. 
 
 
 
 
 
 
 
 
 
 
 
 
 
After OS Maps folders and files have been copied, the installation of Dongle Drivers to add driver support for DiPS 
USB dongle and the second to use the extra reports and features contained within the Custom Reports setup will 
be done if chosen initially. 
 
The dongle drivers will add Deskey K3 drivers, whilst the Custom Reports option will first install SAP Crystal reports 
re-distributable if required and then install the DiPS Custom Reports program. Choose default folder options and 
OK or Next to confirmation messages as they appear. 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Custom Reports (inc Crystal Reports) 
 
Click Next at SAP Crystal Reports and then Accept License Agreement 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After progress indicators, click Finish 



Accept defaults for DiPS CustomReports Installer and then choose Next followed by Finish to complete 

 

 

 

 

 

 

 

 

 

 

 

 

 



File Downloads for DiPS Custom Reports and System Configuration 

 

Company specific installation and report files are now available to download from the DiPS Web site. 

Use the link from the normal Customer Zone page. 

Please click on the relevant company name on the web page to access link to a .ZIP file containing files such as 
Custom report files (.RPT) and configuration files (CSV2DIPS.DAT / .XML files). 

Copy the individual file required (or all the files if applicable) into the DIPS folder to access them from the DiPS 
program. Please contact support@dips.co.uk for help if required. 

 

Running the DiPS Program for the first time 

 

Connect the USB dongle to the appropriate port on the PC and wait for Windows to recognise the device. If 

necessary choose the option to accept pre-installed drivers. 

 

When the DiPS New Egotrip program runs for the first time, the Profile dialog screen will appear.  

Modify the Password field with the required logon password and make sure that the filename  dipsmdbreport.exe 

is in the Custom Reports Filename box. All other fields may be left as blank or defaults unless specifically advised 

by DiPS or as part of your normal installation procedure. 

 

 

mailto:support@dips.co.uk


Windows 11 
 
We have now been able to do some testing with an upgrade from Windows 10 to Windows 11 and can confirm that 
the 2021 installation of program is compatible. The upgrade was done to the Windows version with all programs and 
Office in place. We have listed below some notes that may apply and simple solutions relating to the upgrade. 
 
Initial Message when Loading Data or Exporting using Microsoft Office 2019 installed locally. 
 
Message Box in DiPS has following :- 
 

 
 
Resolution Close DiPS 
 
Solution is to Repair Office in Settings   (Office settings not migrated to Windows11) 

1. Click on Start Menu 

2. Click Apps and Features 

3. Find Office installation (e.g. Microsoft 365 or Office 19) 

4. Click Modify 

5. Choose Quick Repair 

 
 
Re-run DiPS to solve issue 



Environment Settings for Archive / Retrieve a Study 
 
Windows 11 only allows a temporary change after upgrade when choosing DiPS menu option File, Study, Change 
Archive’s Drive 
 

 
 
Use Regedit again to set Permissions to Full Control for all Groups or User Names 
 
Modify the settings for the applicable folder e.g. 
Computer\HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Control Session Manager\Environment 
to allow all Permissions for Everyone / Group / User / Account / PACKAGES etc. 
 
This will allow change to be made to the Archive location as required. 
 

 
 

 
 
 



  
File Downloads for DiPS Custom Reports and System Configuration 
 

Company specific installation and report files are now available to download from the DiPS Web site. 

Use the link from the normal Customer Zone page. 

Please click on the relevant company name on the web page to access link to a .ZIP file containing files 
such as Custom report files (.RPT) and configuration files (CSV2DIPS.DAT / .XML files). 

Copy the individual file required (or all the files if applicable) into the DIPS folder to access them from the 
DiPS program. Please contact support@dips.co.uk for help if required. 

 

 
 
 
 

mailto:support@dips.co.uk


 
 
 
After Saving the required ZIP file just open and then copy and paste the file or files into the DIPS folder 
(normally in local disk C: or another relevant drive if you have selected one for install) 
 
 



 
  
OS Background Maps 

 
DiPS OS Mapping - Choosing the Detail Required 
 
There are three levels of Ordnance Survey mapping normally associated with the standard package.   
Maps can be displayed at scales from 1:2,000,000 (MiniScale), to 1:250,000 (250K) and then 1:50,000 (50K). 
 
Files and folders can be downloaded using the OS Basic Maps Link and the OS 50K Maps Link on the web page (see below) 
 
Examples of a MiniScale map and a 250k map 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Example of a 50K map 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



In addition to these Levels DiPS can also employ two more 
detailed map levels if required. 
 
Detailed Street Level mapping will show road names and 
individual buildings.   
 
As another option an intermediate 10K scale which is a level 
below 50K and will show streets with some main road names  
 
 
 
Example of a Street View map  
 
 
 
 
 
 
 
 
Example of a 10K map  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Installing OS Mapping from Web Site Downloads 
 



 
 
After downloading any of the ZIP files just open and then copy and paste the folders directly into local disk C: (or another drive if 
you have selected one for all your maps) 
 
Select only the drive and not a folder as the files are copied into folders as required.  
 

 
 
Please check that any drive chosen has enough working disk space prior to copying.  
This is not normally an issue on newer PCs but please note that depending upon the levels chosen it may require up to the 
mapping does require up to GIGABYTES of free space! 
 
The standard MiniScale, 250K and 50K maps require 20GB of free space for an initial installation. 
With the StreetView and 10K added it can rise by another 16GB. 



 
To update to the latest program version (not required when installing latest system release) 
 
At the main Customer Area and Software Downloads Page, click on “M3 Update Link” to download the New Egotrip zip file” 
 

 
 
 
When the zip has downloaded or opened, select all the files , right click and from the menu choose “Copy” 
 

 
 
Go to the main DiPS folder (usually in My Computer then local disk C: ) 
Within the main DiPS folder is another folder called WIN. Go into to the “WIN” folder 
Right click on any white space in the WIN folder and click “Paste” 
This will copy the m3.exe and any other required files out of the zip and into the DiPS WIN folder 
 



 
You can check you have updated by running DiPS, go to 
the Help menu and clicking on “About Egotrip”.  
The program version information should show an 
updated program. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Other Updates 
 
Using the link buttons to Postcode updates for recent postcode files, DiPS Manual to view or download a full User Guide in PDF 
format or Custom reports if the installation files for the Report printing facilities are required. 
  

  
 


